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 1. INTRODUCTION TO COMPUTERS 
1 Marks 

2 Marks 

                        

1. First generation computers used 

 a)Vacuum tubes     b) Transistors  

 c) Integrated circuits     d) Microprocessors 

2. Name the volatile memory -  Mar 2022 

 a) ROM   b) PROM    c) RAM   d) EPROM 

3. Identify the output device  

 a) Keyboard  b) Memory   c) Monitor  d) Mouse 

4. Identify the input device  

 a) Printer   b) Mouse    c) Plotter   d) Projector 

5. …………… Output device is used for printing building plan. 

 a) Thermal printer b) Plotter  c) Dot matrix   d) Inkjet printer 

6. Which one of the following is used to in ATM machines 

 a) Touch Screen  b) Speaker  c) Monitor  d) Printer 

7. When a system restarts which type of booting is used. -Mar 2023 

 a) Warm booting  b) Cold booting  c) Touch boot d) Real boot 

8. Expand POST 

 a) Post on self Test    b) Power on Software Test  

 c) Power on Self Test    d) Power on Self Text 

9. Which one of the following is the main memory? -Mar 2024 

 a) ROM   b) RAM   c) Flash drive   d) Hard disk 

10. Which generation of computer used IC’s? –  

 a) First   b) Second   c) Third    d) Fourth 

 

 

1. What is a computer? 

 Computer is an electronic device that processes the input according to the set of 

instructions provided to it and gives the desired output at a very fast rate. 

2. Distinguish between data and information. – Mar 2023 

Data Information 

Data is defined as an unprocessed collection 

of raw facts, suitable for communication, 

interpretation or processing. 

Information is a collection of facts from which 

conclusions may be drawn. 

Example: 134, 16, ‘Kavitha’, ‘C’ are data Example: Kavitha is 16 years old. 

 

3. What are the components of a CPU? 

 Control Unit 

 Arithmetic and Logic Unit 

 Memory Unit 
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3 Marks 

4. What is the function of an ALU? – Mar 2022 

 The ALU (Arithmetic and Logic Unit) is a part of the CPU. 

 The ALU performs arithmetic operations such as addition, subtraction, multiplication, 

division and logical operations. 

5. Write the functions of control unit. – Mar 2024 

 The control unit controls the flow of data between the CPU, memory and I/O devices. 

 It also controls the entire operation of a computer. 

6. What is the function of memory? 

 The primary memory is used to temporarily store the programs and data. 

 Example: RAM (Random Access Memory) 

 The secondary memory is used to store the data permanently. 

 Example: Hard Disk, DVD-ROM. 

7. Differentiate Input and Output unit. 

Input Unit Output Unit 

An Input unit is used to feed any form of data 

to the computer, which can be stored in the 

memory unit for further processing. 

An Output Unit is any hardware component 

that conveys information to users in an 

understandable form 

Example: Keyboard, Mouse Example: Monitor, Printer 

 

8. Distinguish Primary and Secondary memory. 

Primary Memory Secondary Memory 

The Primary Memory is volatile.  The content 

is lost when the power supply is switched off. 

The Secondary Memory is non-volatile. The 

content is available even after the power 

supply is switched off. 

Temporarily store the programs and data. Store the data permanently. 

Example: RAM Example: Hard disk, DVD-ROM. 

 

 

 

1. What are the characteristics of a computer?  

 Computers have revolutionized our lives with their speed, accuracy, storage, reliability, 

versatility, and diligence performing a job, it is truly remarkable. 
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2. Write the applications of computer. 

 Computers are seen everywhere around us, in all spheres of life, in the field of 

education, research, travel and tourism, weather forecasting social networking, e-

commerce etc. 

3. What is an input device? Give two examples -Mar 2023 

 An input device is a hardware or peripheral device used to send data to a computer. 

 It is used to feed any form of data to the computers for processing, display, storage and 

transmission. 

 Example: Keyboard, Mouse 

4. Name any three output devices. 

 Monitor  : To display the information. Like TV 

 Plotter    : It is used to produce graphical output on papers. 

 Printers  : It is used to print the information on papers. 

5. Write short note on impact printer 

 Impact printers print with striking of hammers or pins on ribbon. 

 These printers can print on multi-part by using mechanical pressure. 

 Example: Dot Matrix Printers, Line Matrix Printers. 

6. Write the characteristics of sixth generation.  

 Sixth Generation computers, the era of intelligent computers, based on Artificial 

Neural Networks. 

 The explosive growth of Wide Area Networking. 

 Natural Language Processing is a component of Artificial Intelligence. 

 It provides the ability to develop the computer program to understand human 

language. 

 

7. Write the significant features of monitor. 

 Monitor is the most commonly used output device to display the information. Picture 

elements called Pixels. 

 CRT (Cathode Ray Tube), LCD (Liquid Crystal Display) and LED (Light Emitting 

Diodes).The Monitor works with the VGA (Video Graphics Array) card. 
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5 Marks 

1. Explain the basic components of a computer with a neat diagram. – Mar 2023 

 

 

 

 

 

 

                                                                                                               Data Path 

                                                                                                                Control Path 

 

 

Input unit 

 An Input unit is used to feed any form of data to the computer, which can be stored in 

the memory unit for further processing.   

 Example: Keyboard, Mouse. 

Central Processing Unit 

 CPU is the major components which interprets and executes software instructions. 

Control unit 

 Controls the flow of data between the CPU, Memory and I/O devices. 

ALU (Arithmetic and Logic Unit) 

 The ALU is a part of the CPU.  The ALU performs arithmetic operations such as 

addition, subtraction, multiplication, division and logical operations. 

Memory Unit 

 The Primary Memory is volatile.  The content is lost when the power supply is switched 

off. Temporarily store the programs and data. 

 Example: RAM (Random Access Memory) 

 The Secondary Memory is non-volatile. The content is available even after the power 

supply is switched off.  Store the data Permanently. 

  Example: Hard disk, DVD-ROM. 

Output unit 

 An Output Unit is any hardware component that conveys information to users in an 

understandable form.   

Example: Monitor, Printer. 

Input Unit Output Unit 

Control Unit 

ALU 

Internal 

Memory 

Main Memory 

Secondary Storage 

www.Padasalai.Net                                                                     www.Trb Tnpsc.Com

Kindly Send Me Your Key Answer to Our email id - Padasalai.net@gmail.com

www.P
ad

as
al

ai
.N

et

www.P
ad

as
al

ai
.N

et

https://www.whatsapp.com/channel/0029VaAqUqk9Bb672tBn033m
https://www.padasalai.net/


5 

 

2. Discuss the various generations of computers. -  Mar 2020, Mar 2022 

First Generation 
1940 – 1956 

Vacuum tubes 

o Big in size 

o Consumed more power 

o Malfunction due to over heat 

o Machine Language was used. 

Second 

Generation 

1956 – 1964 

Transistors 

 

o Smaller compared to First Generation 

o Generated Less Heat 

o Consumed less power compared to first 

generation 

o Punched chards were used  

o Machine language as well as Assembly language 

was used. 

Third Generation 
1964 – 1971 

Integrated Circuits 

o Computers were smaller, faster and more reliable 

o Consumed less power 

o High Level Languages were used 

Fourth 

Generation 

1971-1980 

Microprocessor 

VLSI – Very Large 

Scale Integrated 

circuits 

 

o Smaller and Faster 

o Microcomputer series such as IBM and APPLE 

were developed  

o Portable Computers were introduced. 

Fifth Generation 

1980 – till date 

ULSI – Ultra Large 

Scale Integration 

o Parallel Processing 

o Super conductors 

o Computers size was drastically reduced 

o Introduction of Artificial Intelligence 

Sixth Generation In future 

o Parallel and Distributed computing 

o Computers have become smarter, faster and 

smaller 

o Development of robotics 

o Natural language processing 

 

3. Explain the following 

a) Inkjet Printer    b) Multimedia projector     c) Bar code / QR code Reader -Mar 2024 

Inkjet Printer 

 Inkjet Printers are color cartridges Magenta, Yellow and Cyan inks. 

 A black cartridge is also used for monochrome output. 

 The speed of inkjet printers generally range from 1-20 Page Per Minute. 

Multimedia projector 

 It is used to produce computer output on a big screen. 

 These are used to display presentations in meeting halls or in classrooms. 

Bar code 

 A Bar code is a pattern printed in lines of different thickness. 

 The system gives fast and error free entry of information into the computer. 

QR code Reader 

 The QR code is the two dimension bar code which  can be read by a camera and 

processed to interpret the image. 
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2. NUMBER SYSTEMS 

2Marks 

1Marks 
                 

1. Which refers to the number of bits processed by a computer’s CPU? – Mar 2020 

 a) Byte   b) Nibble   c) Word length   d) Bit 

2. How many bytes does 1 KiloByte contain? 

 a) 1000   b) 8    c)4    d) 1024 

3. Expansion for ASCII 

 a) American School Code for Information Interchange 

 b) American Standard Code for Information Interchange 

 c) All Standard Code for Information Interchange 

 d) American Society Code for Information Interchange 

4. 2 ^ 50 is referred as 

 a) Kilo   b) Tera   c) Peta   d) Zetta 

5. How many characters can be handled in Binary Coded Decimal System? 

 a) 64   b) 255   c) 256   d) 128 

6. For 11012 the equivalent Hexadecimal equivalent is? –  

 a) F    b) E    c) D    d) B 

7. What is the 1’s complement of 00100110? – Mar 2023 

 a) 00100110   b) 11011001        c) 11010001     d) 00101001 

8. Which amongst this is not an Octal number? 

 a) 645   b) 234   c) 876   d) 123 

1 Marks: For 11012 the Hexadecimal equivalent is: Ans.: D – Mar 2022 

1Marks: What is the ASCII value for blank space? : Ans: 32  - Mar 2024 

 

 

1. What is data? 

 The term data comes from the word datum, which means a raw fact. 

 The data is a fact about people, places, or some objects. 

2. Write the 1’s complement procedure. 

 Step 1: Convert given Decimal number into Binary 

 Step 2: Check if the binary number contains 8 bits,  

             If less add 0 at the Left most bit, to make it as 8 bits 

 Step 3: Invert all bits Change 1 as 0 and 0 as 1 
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3Marks 

3. Convert (46)10 into Binary number – Mar 2024 

 OR       

 

  

  Ans: (46)10 = (101110)2 

 

4. We cannot find 1’s complement for (28)10. State reason. 

 We cannot find 1’s complement for (28)10.  Because it is a positive number. 

 1’s complement apply only with negative number. 

5. List the encoding systems for characters in memory. 

 BCD – Binary Coded Decimal 

 EBCDIC – Extended Binary Coded Decimal Interchange Code 

 ASCII – American Standard Code for Information Interchange  

 Unicode 

 ISCII – Indian Standard Code for Information Interchange 

 

1. What is radix of a number system? Give example – Mar 2022 

 Each number system is uniquely identified by its base value or radix. 

 Radix or base is the count of number of digits in each number system. 

 Example: (1234)10  (1010)2 (567)8  (1AF)16 

2. Write note on binary number system. 

 Two digits in the Binary Number System, namely 0 and 1. 

 The Binary System are represented to the base 2. Positional multipliers are the powers of 

2. 

 Left most bit is called the MSB and the largest positional weight. 

 Right most bit is called the LSB and the smallest positional weight. 

 

2 46  

 2 23 - 0  LSB 

2 11 - 1 

 2 5 - 1 

 2 2 - 1 

MSB 1 0 

32 16 8 4 2 1 

1 0 1 1 1 0 

MSB     LSB 
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3. Convert (150)10 into Binary, the convert that Binary number to Octal 

Decimal number to Binary 

(150)10 = (   )2 

              OR  

 

 

                  

 

             Ans: (150)10 = (10010110)2 

 

Binary number to Octal 

(10010110)2 = (    )8 

  

 010  010  110                            

   2    2    6 

      Ans: (10010110)2 = (226)8 

 

4. Write short note on ISCII 

 ISCII means Indian Standard Code for Information Interchange.  It is the system of 

handling character of Indian local languages. 

 This as a 8-bit coding system.  It can handle 256 (28) Characters. 

 The year 1986 – 88 and recognized by Bureau of Indian Standards (BIS) 

 

 

2&3Marks Public Examination Questions 

1. What is the decimal equivalent sequence for (547)8 octal sequence? – Mar 2020 -3M Cly 

2. Convert 65(10) into Binary number – Mar 2022 -2M Cly 

3. What is meant by “Signed Magnitude”? – Mar 2023 – 2M Cly 

4. Add: a) (-20)10 + (25)10     b) (22)10 + (15)10 –  Mar 2024 – 3M Cly 

 

 

2 150  

 2 75 - 0  LSB 

2 37 - 1 

 2 18 - 1 

 2 9 - 0 

2  4 - 1 

2 2 - 0 

MSB 1 - 0 

128 64 32 16 8 4 2 1 

1 0 0 1 0 1 1 0 

MSB       LSB 

4 2 1 

1 1 0 

6 
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(15)10 = ( 00001111 )2 

5.  Add  a) -2210 + 1510  b) 2010 + 2510 

a) -2210 + 1510 

(-22)10 = (  )2 

Weight 128 64 32 16 8 4 2 1 

+22    1 0 1 1 0 

8-bit format 0 0 0 1 0 1 1 0 

Carry       1  

1’s Complement 1 1 1 0 1 0 0 1 

Add 1 bit        1 

-22 

2’s 

Complement 1 1 1 0 1 0 1 0 

 

    (-22)10 = ( 11101010 )2 

(15)10 = (   )2 

Weight 128 64 32 16 8 4 2 1 

+15     1 1 1 1 

8-bit format 0 0 0 0 1 1 1 1 

 

-2210 + 1510 = (  )2 

Carry    1 1 1   

-22 1 1 1 0 1 0 1 0 

15 0 0 0 0 1 1 1 1 

-7 1 1 1 1 1 0 0 1 

                          

  Ans: -2210 + 1510 = ( 11111001 )2 

b) 2010 + 2510 

   (20)10 = (   )2 

Weight 128 64 32 16 8 4 2 1 

+20    1 0 1 0 0 

8-bit format 0 0 0 1 0 1 0 0 

     

    (20)10 = ( 00010100 )2 

 

0 + 0 = 0 

0 + 1 = 1 

1 + 0 = 1 

1 + 1 = 10 

10 + 1 = 11 

        Or 

1 + 1 + 1 = 11 
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Ans: (98.46)10  =  ( 1100010 .0111010…)2 

5 Marks 

(25)10 = (   )2 

Weight 128 64 32 16 8 4 2 1 

+25    1 1 0 0 1 

8-bit format 0 0 0 1 1 0 0 1 

    (25)10 = ( 00011001 )2 

2010 + 2510 = (  )2 

Carry   1      

20 0 0 0 1 0 1 0 0 

25 0 0 0 1 1 0 0 1 

45 0 0 1 0 1 1 0 1 

                        Ans: 2010 + 2510 = ( 00101101 )2 

 

1. a) Write the procedure to convert fractional Decimal to Binary 

    b) Convert (98.46)10 to Binary       - Mar 2020, Mar 2023 

a) The procedure to convert fractional Decimal to Binary 

Step 1: Multiply the decimal fraction by 2 and note the integer part. 

    The integer part is either 0 or 1. 

Step 2: Discard the integer part of the previous product. 

    Multiply the fractional part of the previous product by 2. 

    Repeat Step 1 until the same fraction repeats or terminates(0). 

Step 3: The resulting integer part forms a sequence 0s and 1s that become the binary 

equivalent of decimal fraction. 

Step 4: The final answer is to be written from first integer part obtained till the last integer 

part obtained. 

 

b) Convert (98.46)10 to Binary 

i) Integer part 

 (98)10  =  (  )2 

    

 

 

 

 

 

2 98  

 2 49 - 0    LSB 

2 24 - 1 

 2 12 - 0 

 2 6 - 0 

2  3 - 0 

MSB 1 - 1 

(0.46)10 =(  )2 

0.46 x 2 = 0.92 = 0 

0.92 x 2 = 1.84 = 1 

0.84 x 2 = 1.68 = 1 

0.68 x 2 = 1.36 = 1 

0.36 x 2 = 0.72 = 0 

0.72 x 2 = 1.44 = 1 

0.44 x 2 = 0.88 = 0 
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2. Find 1’s Complement and 2’s Complement for the following Decimal number  

a) -98   b) -135 

(-98)10 = (  )2 

Weight 128 64 32 16 8 4 2 1 

+98  1 1 0 0 0 1 0 

8-bit format 0 1 1 0 0 0 1 0 

Carry       1  

1’s 

Complement 

1 0 0 1 1 1 0 1 

Add 1 bit        1 

-98 

2’s 

Complement 1 0 0 1 1 1 1 0 

 

   (-98)10 = ( 10011110 )2 

(-135)10 = (  )2 

Weight 256 128 64 32 16 8 4 2 1 

+135  1 0 0 0 0 1 1 1 

8-bit format 0 1 0 0 0 0 1 1 1 

Carry          

1’s 

Complement 

1 0 1 1 1 1 0 0 0 

Add 1 bit         1 

-98 

2’s 

Complement 1 0 1 1 1 1 0 0 1 

 

   (-135)10 = ( 101111001 )2 

 

 

 

 

 

 

0 + 0 = 0 

0 + 1 = 1 

1 + 0 = 1 

1 + 1 = 10 

10 + 1 = 11 

        Or 

1 + 1 + 1 = 11 
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3. a) Add 11010102 + 1011012  - Mar 2023 

    b) Subtract 11010112 – 1110102 

a) Add 11010102 + 1011012 

Carry 1  1 

  1 1 0 1 0 1 0  

   1 0 1 1 0 1 

  

 1 0 0 1 0 1 1 1 

 

  11010102 + 1011012  = 100101112 

 

b) Subtract 11010112 – 1110102 

Borrow  0 10 10 

  1 1 0 1 0 1 1 

   1 1 1 0 1 0 

 

  0 1 1 0 0 0 1 

  

  11010112 – 1110102 = 01100012 

 

5 Marks – Public Examination Question 

1.Convert the following Decimal numbers to its equivalent Binary, Octal and Hexadecimal.-Mar 

2022       i)255        ii) 126 

2. i) Convert(58.46)10 to Binary – Mar 2024 

ii) Find 1’s Complement and 2’s Complement for the following Decimal Numbers.  1) -24 2) -65 

0 + 0 = 0 

0 + 1 = 1 

1 + 0 = 1 

1 + 1 = 10 

10 + 1 = 11 

        Or 

1 + 1 + 1 = 11 

 

 

 

0 - 0 = 0 

0 - 1 = 1 (borrow) 

1 - 0 = 1 

1 - 1 = 0 

10 - 1 = 1 
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1. Which of the following is said to be the brain of a computer? 

             a) Input devices   b) Output devices  

             c) Memory device   d) Microprocessor 

2. Which of the following is not the part of a microprocessor unit?  

              a) ALU   b) Control unit  

              c) Cache memory   d) register 

3. How many bits constitute a word? 

              a) 8                            b) 16  

              c) 32                          d) determined by the processor used. 

4. Which of the following device identifies the location when address is 

placed in the memory address register? 

              a) Locator                      b) encoder  

              c) decoder                           d) multiplexer 

5. Which of the following is a CISC processor? – Mar 2020 

              a) Intel P6                         b) AMD K6  

              c) Pentium III                  d) Pentium IV  

6. Which is the fastest memory? 

              a) Hard disk                       b) Main memory  

              c) Cache memory             d) Blue-Ray disc 

 3. COMPUTER ORGANIZTION 

1 Marks 
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7. How many memory locations are identified by a processor with 8 bit 

address bus at a time?  

            a) 28  b) 1024   

            c) 256  d) 8000 

8. What is the capacity of 12cm diameter DVD with single sided and 

single layer? 

             a) 4.7 GB                        b) 5.5 GB  

             c) 7.8 GB                        d) 2.2 GB 

9. What is the smallest size of data represented in a CD? -Mar 2023 

              a) blocks                         b) sectors  

              c) pits        d) tracks 

10. Display devices are connected to the  computer through.  

               a) USB port              b) Ps/2 port  

               c) SCSI port                   d) VGA connector 

11. Which of the following is a RISC Processor? – Mar 2024 

a) Pentium III          b) Pentium IV       c) Intel 386             d) Pentium II 
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1. What are the parameters which influence the characteristics of a 

microprocessor? 

 Clock Speed 

 Instruction set 

 Word size 

2. What is an instruction? 

      A command which is given to a computer to perform an operation 

on data is called an instruction. 

3. What is a program counter? -Mar 2023 

 The Program Counter (PC) is a special register in the CPU which 

always keeps the address of the next instruction to be executed. 

 The Arithmetic and Logic Unit of CPU places the address of the 

memory to be fetched into the Memory Address Register 

4. What is HDMI? 

 High-Definition Multimedia Interface is an audio/video interface  

 which transfers the uncompressed video and audio data from a 

video controller, 

 To a compatible computer Monitor, LCD projector, Digital 

Television etc. 

 

5. Which source is used to erase the content of a EPROM?   

 Ultraviolet rays is used to erase the content of a EPROM 

2 Marks 
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3 Marks 

1. Differentiate Computer Organization from Computer 

Architecture. 

Computer Organization Computer Architecture 

Computer organization deals with 

the hardware components of a 
computer system such as Input / 

Output devices,  CPU, Storage 

Devices and Primary Memory. 

Computer Architecture also deals 

with how they are interconnected 
to implement an architectural 

specification. 

It deals with the hardware 
components that are transparent to 

the programmer. 

It deals with the engineering 
considerations involved in 

designing a computer. 

 

2. Classify the microprocessor based on the size of the data. – Mar23 

 Depending on the data width, microprocessors can process instructions. 

 8-bit microprocessor 

 16-bit microprocessor 

 32-bit microprocessor 

 64-bit microprocessor 

3. Write down the classifications of microprocessors based on the 

instruction set. – Mar 2024 

 The size of the instruction set is important considerations while 

categorizing microprocessors. 

 Reduced Instruction Set Computers (RISC) 

          Example: Pentium IV, Inter P6, AMD K6 and K7 

 Complex Instruction Set Computers (CISC) 

           Example: Intel 386 & 486, Pentium, Pentium II and III. 
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4. Differentiate PROM and EPROM 

PROM EPROM 

Programmable read only memory 

is a non-volatile memory 

Erasable Programmable Read 

Only Memory is a special type of 
memory. 

PROMs retain their contents even 

when the computer is turned off. 

EPROM  retains its contents until 

it is exposed to ultraviolet light. 

PROM can be written only once 

and cannot be erased. 

Ultraviolet rays is used to erase the 

content of a EPROM 

 

5. Write down the interfaces and ports available in a computer. 

 Serial Port: To connect the external devices, found in old computers. 

   Parallel Port: To connect the printers, found in old computers. 

   USB Ports: To connect external devices like cameras, scanners etc. 

   VGA Connector: To connect a monitor or LCD Projector. 

   Audio Plugs: To connect sound speakers, microphone etc. 

   PS/2 Port: To connect mouse and keyboard to PC. 

 SCSI Port: To connect the hard disk drives and network connectors. 

6. Differentiate CD and DVD  

CD DVD 

CD stands for Compact Disk DVD stands for Digital Versatile 

Disc. 

CD data is represented as tiny 

indentations known as “pits” 

DVD-ROM can be visually 

determined nothing the number of 
data sides of the disc. 

Capacity: CD-ROM is 700 MB Capacity: DVD is 4.7GB 

Single –layered sides are usually 

silver-coloured 

Double-layered sides are usually 

gold-coloured. 
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7. How will you differentiate a flash memory and an EEPROM? 

Flash Memory EEPROM 

Flash memory is an electronic        

(solid-state) non-volatile computer 
storage. 

Electrically Erasable 

Programmable Read Only 
Memory is a special type of PROM 

Flash memory offers fast access 

times. 

EEPROM is slower in 

performance. 

It can be erased by exposing it to 

an electrical charge. 

It can be electrically erased and 

reprogrammed. 

 

 

1. How the read and write operations are performed by a processor? 

Explain. 

 The CPU has a Memory Data Register(MDR) and a Memory 

Address Register (MAR). 

 The Memory Data Register (MDR) Keeps the data which is 

transferred between the Memory and the CPU.  

 The Program Counter (PC) is a special register in the CPU which 

always keeps the address of the next instruction to be executed.  

 A bus is a collection of wires used for communication between the 

internal components of a computer. 

 The word in the RAM has the same size (no. of bits) as the 

Memory Data Register (MDR).  

 If the processor is an 8-bit processor like Intel 8085, its MDR and 

the word in the RAM both have 8 bits.  

 The read operation transfers the data (bits) from word to Memory 

Data Register. 

 The write operation transfers the data(bits) from Memory Data 

Register to word. 

5 Marks 
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2. Explain the characteristics of a microprocessor. – Mar 2020 

 Clock speed 

 Instruction set 

 Word size 

Clock speed 

          Every microprocessor has an internal clock that regulates the speed 

at which it executes instructions is called the clock speed. Clock speed is 

measured in MHz(Mega Hertz) or in GHz(Giga Hertz). 

Instruction Set 

          A command which given to a computer to perform an operation on 

data is called as an instruction set. 

 Data transfer 

 Arithmetic operations 

 Logical operations 

 Control flow 

 Input/output 

Word Size 

          The number of bits that can be processed by a processor in a 

single instruction is called its word size. 

          Word size determines the amount of RAM that can be accessed by 

a microprocessor. 
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3. Arrange the memory devices in ascending order based on the 

access time. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hard Disk 

Main Memory 

  Cache 

Memory 

Smaller 

capacity, faster 

access time and 

higher cost  

Larger capacity, 

slower access 

time and Lower 

cost 
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4. Explain the types of ROM. – Mar 2022,Mar 2024 

 Read Only Memory 

 Programmable Read Only Memory 

 Erasable Programmable Read Only Memory 

 Electrical Erasable Read Only Memory 

Read Only Memory (ROM) 

          Read only memory refers to special memory in a computer with 

pre-recorded data at manufacturing time which cannot be modified. 

Programmable Read Only Memory (PROM) 

Programmable read only memory is a non-volatile memory. 

PROMs retain their contents even when the computer is turned off. 

PROM can be written only once and cannot be erased. 

Erasable Programmable Read Only Memory (EPROM) 

Erasable Programmable Read Only Memory is a special type of 

memory. 

EPROM  retains its contents until it is exposed to ultraviolet light. 

Ultraviolet rays is used to erase the content of a EPROM 

Electrically Erasable Programmable Read Only Memory 

(EEPROM) 

Electrically Erasable Programmable Read Only Memory is a 

special type of PROM 

EEPROM is slower in performance. 

It can be electrically erased (electrical charge) and reprogrammed. 
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1. Operating System is a  

 a) Application Software     b) Hardware  

 c) System Software      d) Component 

2. Identify the usage of Operating Systems 

 a) Easy interaction between the human and computer  

 b) Controlling input & output Devices 

 c) Managing use of main memory 

 d) All the above 

3. Which of the following is not a function of an Operating System? – 

Mar 2023 
 a) Process Management  b) Memory Management 

 c) Security Management  d) Complier Environment 

4. Which of the following OS is a Commercially licensed Operating 

system? 

 a) Windows  b) UBUNTU  c) FEDORA  d) REDHAT 

5. Which of the following Operating systems support Mobile Devices? 

 a) Windows 7  b) Linux   c) BOSS   d) iOS 

6. File Management manages  - Mar 2022 

 a) Files  b) Folders     c) Directory systems d) All the above 

7. Interactive Operating System provides   

 a) Graphics User Interface(GUI) b) Data Distribution 

 c) Security Management   d) Real Time Processing  

8. An example for single task operating system is  

 a) Linux b) Windows  c) MS-DOS  d) Unix 

9. The File management system used by Linux is – Mar 2024 

 a) ext2  b) NTFS  c) FAT   d) NFTS 

10. How many level of securities is provided by OS to the user?  

 a) 3   b) 2   c) 5    d) 4 

4.  THEORETICAL CONCEPTS OF OPERATING SYSTEM 

1 Marks 
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1. List out any two uses of Operating System?  

 To ensure that a computer can be used to extract what the user 

wants it do. 

 Easy interaction between the users and computers. 

 Controlling Input and Output Devices. 

2. What is  multi-user Operating system?  - Mar 2023 

 Multi-user Operating system is used in computers and laptops that 

allow same data and applications to be accessed by multiple users 

at the same time. 

 The users can also communicate with each other. 

 Example: Windows, UNIX and Linux 

3. What is a GUI?  - Mar 2023 (3M) 

 The GUI is a window based system with a pointing device to direct 

I/O, choose from menus, make selections and a keyboard to enter 

text. 

 Its vibrant colours attract the user very easily. 

4. What are the security management features available in 

Operating System? 

 File access level 

 System level 

 Network level 

 

2 Marks 
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5. What is multi-processing? 

 Multi-processing is a one of the features of Operating System. 

 It has two or more processors for a single running process. 

 Processing takes place in parallel is known as parallel processing. 

6. What are the different Operating  Systems used in computer? – 

Mar 2024 

 Operating Systems used in personal computers and laptops are 

Windows, UNIX and Linux. 

 Single User Operating Systems 

 Multi-user Operating Systems 

 Distributed Operating Systems 

 

 

1. What are the advantages and disadvantages of Time-sharing 

features?  

Advantages Disadvantages 

It allows execution of multiple 

tasks or processes concurrently. 

Problem of reliability. 

Quick response. Question of security and integrity 
of user programs and data. 

Avoids duplication of software. Problem of data communication. 

Reduces CPU idle time. Various processes after a time is 

elapsed. 

 

 

3 Marks 
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2. List out the key features of Operating system – Mar 2022 

 User Interface 

 File Management 

 Memory Management 

 Fault Tolerance 

 Process Management 

 Security Management 

3. Write a note on Multiprocessing 

 Multi-processing is a one of the features of Operating System. 

 It has two or more processors for a single running process. 

 Processing takes place in parallel is known as parallel processing. 

 The execution takes place in parallel, this feature is used for high 

speed execution which increases the power of computing. 

 

 

1. Explain the concept of a Distributed Operating System along with 

its advantages.  – Mar 2020, Mar 2022 

 The Distributed Operating System is used to access shared data 

and files that reside in any machine around the world. 
 The user can handle the data from different locations.  The users 

can access as if it is available on their own computer. 

Advantages of Distributed Operating System 

 A user at one location can make use of all the resources available 

at another location over the network. 
 Many computer resources can be added easily in the network. 

 Improves the interaction with the customers and clients. 

 Reduces the load on the host computer. 

5 Marks 
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2. List out the points to be noted while creating a user interface for 

an Operating system. – Mar 2024 

 The user interface should enable the user to retain this expertise for 

a longer time. 

 The user interface should also satisfy the customer based on their 

needs.  

 The user interface should save user’s precious time. 

 The ultimate aim of any product is to satisfy the customer. The 

User Interface is also to satisfy the customer. 

 The user interface should reduce number of errors committed by 

the user. 

 

3. Explain the process management algorithms in Operating System.  

 Process management is function that includes creating and deleting 

processes and providing mechanisms for processes to communicate and 

synchronize with each other. 

 A system task, such as sending output to a printer or screen can 

also be called as a Process. 

 FIFO (First In First Out) 

 SJF (Shortest Job First) 

 Round Robin  

 Based On Priority 

FIFO (First In First Out) Scheduling 

 FIFO algorithm is based on queuing technique. 

 The processes are executed in the order of the queue (row). 

Example: 

 Student standing a queue can get their Grade sheet. 
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SJF (Shortest Job First) Scheduling 

 This algorithm works based on the size of the job being executed 

by the CPU. 

Example: 

Take Two jobs A and B 

A= 6 kilo bytes  B= 9 kilo bytes 

First the job “A” will be assigned and then job “B” gets its turn. 

Round Robin Scheduling 

 The Round Robin scheduling algorithm is designed especially for 

time sharing systems. 

 Jobs are assigned and processor time in a circular method. 

Example: 

 Take three jobs A, B, C. Fist the job A is assigned to CPU the job 

B and job C and then again A, B and C and so on. 

Based on Priority 

 The give job is assigned based on a Priority. 

 The job which has higher priority is more important than other 

jobs. 

Example: 

  Take two jobs A and B. Let the priority of A be 5 and priority B be 7. 

  Job B is assigned to the processor before job A. 
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1. From the options given below, choose the operations managed by the 

operating system. 

 a) Memory     b) Processes  

 c) Disks and I/O devices   d) All of the above 

2. Which is the default folder for many Windows Applications to save 

your file? – Mar 2020 

 a) My Document   b) My Pictures  

 c) Documents and Settings  d) My Computer 

3. Under which of the following OS, the option Shift + delete will 

permanently deletes a file or folder?  

 a) Windows 7     b) MS-DOS  

 c) Linux      d) Android OS 

4. What is the meaning of “Hibernate”  in Windows  XP/ Windows 7? 

 a) Restart the Computer in safe mode. 

 b) Restart the Computer in hibernate mode. 

 c) Shutdown the Computer terminating all the running applications 

 d) Shutdown the Computer without closing the running     

              applications 

5. The shortcut key used to rename a file in windows – Mar 2023 

 a) F2   b) F4   c) F5   d) F6    

5. WORKING WITH WINDOWS OPERATING SYSTEM 

 1 Marks 
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1. What is known as Multitasking? 

 Multiple applications can execute simultaneously in Windows, and 

this is known as “Multitasking”. 

2. What are called standard icons – Mar 2022 

 Icons which are available on desktop by default while installing 

Windows OS are called standard icons. 

3. Differentiate Files and Folders. 

Files Folders 

A file consists of a collection of 
data. 

A folder stores files and folders. It 
is also called a directory. 

Each file has its own extension. A folder does not have any 

extension 

Folder and sub folder cannot be 

created in a file 

Folder and sub folder can be 

created in a folder. 

 

4. Differentiate Save and Save As option. 

Save Save As 

“Save” command is used to save a 
document by only one name 

“Save As” command can save a 
file by two or more than two 

names. 

Shortcut Key: Ctrl + S Shortcut Key: Ctrl + Shift+ S 

 

5. How will you Rename a File? – Mar 2023 

 Rename files or folders can be done in number of ways such as 
using the File menu, left mouse button or right mouse button. 

 Select the File 

 Click File → Rename 
 Type in the new name. 
 To finalise the renaming operation 

 2 Marks 
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1. What are the functions of Windows Operating system.– Mar 2022 

 Access applications on the computer. 

 Load any new program on the computer. 

 Manage hardware. 

 File management activities. 

 Change computer settings. 

2. Write a note on Recycle bin. 

 Recycle bin is a special folder to keep the files or folders deleted 

by the user. 

 The user cannot access the files or folders available in the Recycle 
bin without restoring it. 

 Restore option is used to restore the file or folder from the Recycle 

bin. 
 To delete all files in the Recycle bin, select Empty the Recycle bin. 

3. Write a note on the elements of a window. 

 Title Bar – Display the name of the application and the name of 

the document. 
 Menu Bar – Menus in the menu bar can be accessed by pressing 

Alt key. 

 The Workspace – Enter or type the text of your document. 
 Scroll bars – Scroll the workspace horizontally or vertically. 

 Corners and borders – To drag and resize the windows. 

 

4. Write the two ways to create a new folder.  – Mar 2024 

Method I 

Step 1: Open Computer Icon. 

Step 2: Open any drive where you want to create a new folder. 

Step 3: Click on File → New → Folder. 

Step 4: A new folder is created with the default name “New 
folder”. 

Step 5: Type in the folder name and press Enter key. 

 3 Marks 
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Method II 

Step 1: In the Desktop, Right click →  New → Folder 
Step 2: A Folder appears with the default name “New folder” and 
it will be highlighted. 

Step 3: Type the name you want and press Enter Key. 

Step 4: The name of the folder will change. 

 

5. Differentiate copy and move- Mar 2023 

Copy Move 

Copy option is used to copy a file 
or folder, and paste in a specified 

location. 

Cut option is used to move a 
selected file or folder from one 

place to another. 

Edit → Copy or  
Ctrl + C or  

Right click→Copy 

Edit → Cut or 
Ctrl + X or  

Right click → Cut 

 

 

 

3. Write the procedure to create shortcut in Windows OS. 

 Shortcuts to you most often used folders and files may be created 

and placed on the Desktop to help automate your work. 

 Select the file or folder that you wish to have as a shortcut on the 

Desktop. 

 Right click on the file or folder. 

 Select Send to from the shortcut menu, then select Desktop(create 

shortcut) from the sub-menu. 

 A shortcut for the file or folder will now appear on your desktop 

and you can open it from the desktop in the same ways an any 

other icon. 

 

 5 Marks 
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1. Explain the versions of Windows Operating System. – Mar 2023 

Versions Year Specific features 

Windows 1.x 1985 
Introduction of GUI in 16 bit processor 
Mouse was introduced. 

Windows 2.x 1987 
Minimize or Maximize windows. 

Control panel feature was introduced. 

Windows 3.x 1992 
Introduced the concept of multitasking. 

Supported 256 colours . 

Windows 95 1995 

Introduced start button, taskbar, Windows Explorer 

and Start menu. 

Introduced 32 multiprocessor. 

Windows 98 1998 
Web browser (Internet Explorer) with the OS. 

Plug and play feature was introduced. 

Windows 

NT 
 

Designed to act as servers in network. 

Windows 

Me 
2000 

Introduced automated system diagnostics and 

recovery tools. 

Windows 

2000 
2000 

Served as an Operating System for business desktop 

and laptop systems. 

Windows 

XP 
2001 

Introduced 64-bit processor. 

Improved Windows appearance with themes and 

offered a stable version. 

Windows 

Vista 
2006 

Updated the look and feel of Windows. 

Windows 7 2009 

Booting time was improved, User interface like Aero 

Peek, pinning programs to taskbar, handwriting 

recognition etc. and Internet Explorer 8. 

Windows 8 2012 

Start button was removed. 

multi-core processing, solid state drives, touch screens 

and other alternate input methods. 

Windows 10 2015 

Start Button was added again. 

Multiple desktop. 

Central Notification Center for App notification and 

quick actions. 

Cortana voice activated personal assistant. 
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2. Explain the different ways of finding a file or Folder. – Mar 2024 

 

To find a file or folder: 

 

 Click the Start button, the search box appears at the bottom of the 
start menu. 

 Type the name of the file or the folder you want to search. 

 The files or the folders with the specified names will appear, if you 
click that file, it will directly open that file or folder. 

 It will display the list of files or folders starting with the specified 

name. 
 There is another option called “See more results” which appears 

above the search box. 

 If you click it, it will lead you to a Search Results dialog box 
where you can click and open that file or the folder. 

 

Searching Files or folders using Computer icon 

 

 Click Computer Icon from desktop or from Start menu. 

 The computer disk drive screen will appear and at the top right 
corner of that screen, there is a search box option. 

 Type the name of the file or the folder you want to search. 

 It will display the list of files or folders starting with the specified 
name. 

 Just click and open that file or the folder. 

 

 

1 Marks 

1. Which is displayed at the top part of the window? – Mar 2022 

     Ans.: Title bar 

2. Which menu contains the Numbering option? – Mar 2024 

     Ans.: Format 

3Marks 

1. Compare – Cut, Paste and Copy, Paste – Mar 2023 
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